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1. Books Required reading:
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reports...).
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Looking at the desktop: navigation on desktop; using start button;
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Files and folders: looking at typical window, moving, and sizing window.
Using scroll bar, understanding and using to my computer and recycle
bin. Concepts of drives, folders, and files (differences and importance);
Directory and folder hierarchy and structure; understanding file name
and common extensions.
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Folder and file management (Create, copy, cut, delete, rename, find,
and move); common keyboard shortcuts, undelete folder and files using
recycle bin, display the differences between uninstall and undelete or

delete.
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Looking inside a computer (microprocessor, system memory, storage
systems) recognizing input/ output devices (using keyboard, pointing
devices, microphones, monitor, printers, projector, and speakers)
understanding how it works together.
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using control panel customizing desktop and display, changing date and
time, changing language, accessibility settings.
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Lesson 4 Control Panel

Programs Provides access to system management tasks such as installing and
uninstalling programs.

User Accounts Provides options for setting the computer up to be used by more than one
person.

Appearance and Allows you to customize your screen with screen savers, desktop

Personalization backgrounds, and so on.

Clock, Language, and Provides access so you can change the format of dates, times, currency, or

Region numbers to reflect regional standards or languages.

Ease of Access Provides options for changing accessibility specifications, such as turning on

voice recognition or altering visual displays.

Some of the more commonly used features in Control Panel include changing options for the:

¢ desktop background e date ortime
s screen saver e sounds that accompany specific actions in Windows
¢ mouse or keyboard ¢ audio volume

If you prefer to see icons for Control Panel items, you can switch the display to Large icons or Small
icons:
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The Control Panel is the area in Windows where you can access features to either install or customize
the settings for devices on your system.

Use one of the following methods to access the Control Panel:

o Click Start, Control Panel; or

e« in Windows Explorer, click Computer in the Navigation pane, then click | OpenControlPanel | in the
Command bar.

r = ~
—~— - .
A ‘@ » Control Panel » - ‘ 3 ‘ ||js:rf-~ Control Panel 2 |
Adjust your computer's settings View by: Category ¥
? System and Security 3; User Accounts
N Review your computer's status C
. B L Change account type
\9 Back up your computer J w geacee Pe
Find and fix problems Appearance and
=_  Network and Internet Personalization
ul View network status and tasks ‘jh‘mge the theme
- Cheose homegroup and sharing opticns Change desktop background

Adjust screen resolution

| Hardware and Sound .

¥ View devices and printers : Clock, Language. and REQIOH

N Add a device - Change keyboards or other input
methods

Connect to a projector

Adjust commonly used mobility settings Ease of Access
Let Windows suggest settings

Optimize visual display

\' )
=% Programs \
Uninstall a program

Get programs

L J

System and Security Provides options for maintaining system integrity, performing data backups,
checking for updates and scanning downloads.

Network and Internet | Allows you to set up or modify how your system connects to a network or
the Internet, and to share files with others.

Hardware and Sound Enables you to set up or modify the way hardware items such as sound
devices will work.
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Understanding power options ( shutdown, sleep, Hibernate), Working
with all settings working with power settings identifying need of
operation safe mode and normal mode understanding user accounts
and rights create new user account, change in controls; rights and

access).
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Understanding Power Options

E Exam 1 - Objective 1.3

Every computer has a power supply that converts the AC power from an outlet into DC power that the
computer can use. The computer receives power using a power cord that is plugged into a standard
electrical outlet. All portable computing devices include an internal or additional battery that allows
you to use the computer without plugging it into an electrical outlet.

As you learned in Lesson 1, there are various methods for properly exiting Windows. These include
shutting down, going into sleep or standby mode, and going into hibernation mode. These modes are
reviewed here. Windows also provides power options and power plans that allow you to specify how
power is used, and when the display and/or hard disks are put into sleep mode.

Shutting Down

When you are finished using your computer, turning it off properly is important, not only to save
energy, but also to ensure that your data is saved. The three ways to turn off your computer are
pressing the power button, using the Shut down button on the Start menu, and, on a notebook, closing
the lid.

To shut down, click the Start button, then in the lower-right corner of the Start menu, click Shut down,
When you shut down, the computer closes all open files, applications and the operating system, then
completely turns off the computer and display. Shutting down does not save files. You must save your
work before you shut down. Restarting your computer after shutting down takes longer than waking
the computer from sleep/standby or from hibernation.

Sleep

As an alternative to shutting the system down, you can put the computer to sleep. When a computer
is in sleep mode, the display turns off and often the computer's fan stops. The whole process takes
only a few seconds.

When you put the computer into sleep mode, Windows puts your work and settings into memory and
then draws only a low amount of power. It is not necessary to close programs and files before putting
the computer into sleep mode. However, it is always a good idea to save your work before putting the
computer into any low-power mode (to prevent data loss in the event of a power failure). When you
wake the computer, the screen will look exactly as it did when you put it to sleep.

To wake the computer from sleep, move the mouse or press a key. Because you do not have to wait
for Windows to start, your computer wakes within seconds and you can resume work almost
immediately.

When the computer is in sleep mode, it uses very little power to maintain all current work in memory.
After a computer has been asleep for several hours, or if the battery is running low, your work is
automatically saved to the hard disk and the computer turns itself off completely. This can also be
adjusted to your preferences using the Power Options.

Hibernate

Hibernation is a power-saving state designed primarily for notebooks. In hibernation mode, the
computer puts your open documents and programs on the hard disk and then turns off the computer.
Of all the power-saving states in Windows, hibernation uses the least amount of power.
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What is software (Checking system requirements, and hardware
implications); application software; integrated sheets; desktop
publishing; spreadsheet; database management; presentation; Art;
Engineering; mathematics; statistics; medical; management; content
creation; multimedia; entertainment; system protection) management
(software (install a new one, uninstall, reinstall, and updating software
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What is a Software Program?

The term computer software refers to everything that makes a computer run, including operating
systems, programming software, and application programs.

A computer program is a sequence of instructions written to perform a specified task. The instructions
which constitute a program are written by computer programmers who use special programming
languages. A programming language allows the programmer to write instructions and calculations in
a human-readable form called source code.

In order to prepare a program for use by a computer, the programming language compiles the source
code into an executable form. That is, the source code is changed into machine code — a form that the
computer can use.

While creating the source code for a program can be a very complex process, using the finished
program is generally as easy as clicking a button or entering text. The program's code works "behind
the scenes" to interpret mouse clicks, keystrokes and menu selections or to display messages and text
on the screen. :

. B Y SeLength g qryy

Software programs can create documents, record sounds, manipulate
images, carry out complex calculations, and perform an enormous
variety of other tasks. You have an almost infinite humber of choices
when selecting software. Your choice should be based on what you
need to accomplish, the degree of detail and features you need, and
what is most cost-effective.

.

-

O i

st GWLp LEP

Obtaining Software
E Exam 1 - Objective 3.2

All retail software programs are thoroughly tested before they are released to the public. Software
vendors perform quality control tests on their software to minimize problems that can occur once you
install the program. The cost of software often includes future updates to the program.

When you purchase a software program, you are purchasing a license to install and use that program
on one computer only. This is also known as a sing/e seat license. The traditional method of purchasing
software is to obtain the program on CD or DVD in a package which may include a booklet with
instructions on how to install and use the program.

49



Ministry of Higher Education & Scientific Research
Al-Rasheed University College

Department of Medical Engineering
instrumentation Technique

ol Codlg Jladl @dasdl 8139
daslndl wds i A8

dudall 83421 LGS duwdid eud

4881...90.... ;s - b ydlad) 3 alaal) - Y Baa )

8 oladl 8 ailoeal! LB
e 1038 Quildall ¢ 9 of Aada) Algs A ad gl
lall Ga il pasd Lo il 7
Ledara g cililall Cada 48K e o el 8
o= Al (g 8 Ll al sl 5 Sl s ldll (e (alll 488 o a3l 9
AbliaYi awill Jee e o =110

15 ulal B polonedl Ole gub g

Disk management programs (disk cleanup, check, optimize, and
compression) what is troubleshooting? managing hardware / software;
keep copies of data; dealing with viruses, malware and Trojans, getting

Windows help and support
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File Compression Utilities

A file compression utility can be very useful when you need to reduce the size of one or more files,
usually for the purpose of transferring the file(s) from one location to another (for example, as an email
attachment). Compressing one or more files is also referred to as zipping, much like when you stuff a
tote bag as full as possible and then press everything down to make it fit prior to zipping (closing) the
bag.

Some files are larger than others, simply by the nature of the type of file. For example, video files are
usually very large and should be converted to a compressed format (such as .avi) so they can be
shared. Music files in .wav format are generally converted to .mp3 format to make them smaller for
sharing. Picture files with a .tif or .bmp file type tend to be large in size and are compressed to a .png
or .jpg format. The image, audio and video files you encounter on the Internet are already in a
compressed format, which reduces the time required to download them to a web browser.

Checking the System Requirements

System requirements identify the type of hardware (and operating system version) required to
successfully run the program. All software, whether operating system software or application program
software, is designed to work with hardware that can be expected to function at a specific speed and
capacity. The software vendor lists these expectations so you can determine whether your computer
is compatible and meets (and hopefully exceeds) all the requirements before purchasing the program.
System requirements always appear on the software package if you purchase it in a retail store; if you
purchase a license or other electronic means such as downloading from the software vendor’s web
site, the system requirements are listed on the site, usually before you click the Download or Purchase
button.

A system requirements checklist may appear similar to the following:

Required Processor 1 gigahertz (Ghz) or faster x86- or x64-bit processor with SSE2 instruction set

Required Operating Windows 8, Windows 7, Windows Server 2008 R2, or Windows Server 2012
System

Required Memory 1 GB RAM (32 bit); 2 GB RAM (64 bit)

Required Hard Disk 2.0 GB available
Space

Required Display Graphics hardware acceleration requires a DirectX 10 graphics card and 1024 x 576 resolution

Required .NET 35,40, 0r45

Version

Multi-touch A touch-enabled device is required to use any multi-touch functionality. However, all features and functionality are

always available by using a keyboard, mouse, or other standard or accessible input device. Note that new touch
features are optimized for use with Windows 8.

Additional System Some functionality may vary, based on the system configuration. Some features may require additional or advanced
Requirements hardware or server connectivity.

If you are unsure of the type of hardware installed in your computer, check with a technical specialist
before purchasing the software.
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What is key applications what it can do?; getting started (start and exit
program), looking at the main screen (for word, excel, and PowerPoint),
accessing commands and characteristic features, understanding ribbon;
tabs; status bar; scroll bar; create files from templates, how to get help,

.manipulation files and data exchange
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Choosing an Application Program

E Exam 1 - Objective 3.3, 3.4

Before you install any application software, an operating system must be installed on the system. The
operating system controls the computer hardware and acts as a host for any application program you
want to run on the computer. Application software programs are designed to be compatible with
specific versions of an operating system. For example, a program may be designed to waork with
Windows 7 or higher. You should always check the box (if you purchase software from a retailer) or
check the specifications listed on the web site (if you purchase and download an application program
over the Internet) to ensure that the program you are purchasing is compatible with your operating
system.

Hardware Implications

As discussed earlier, application software is written with the assumption that specific types of hardware
will be used. This means that the hardware in your system can determine which operating system and
application software you can install, and your operating system and application software can determine
which hardware you can use.

For example, some systems use 32-bit processors and others use 64-bit processors. Systems with 64-
bit processors can run either a 32-bit or a 64-bit version of Windows; but systems with 32-bit
processors can run only a 32-bit version of Windows.

Computers running 64-bit versions of Windows can run 32-bit or 64-bit versions of application
software. Computers running 32-bit versions of Windows can run only 32-bit versions of application
software.

Additionally, operating systems require small programs called device drivers to communicate with
installed hardware devices. A computer running a 64-hit version of Windows requires 64-bit device
drivers. If you have some older hardware, such as a scanner or wireless network card, and you
purchase a new computer that runs 64-bit Windows, you will nheed 64-bit drivers to enable the new
computer to work with your older scanner or wireless network card. If 64-bit drivers are not available
for these devices, you will not be able to use them with the new computer.

Software vendors will list the minimum requirements for processor speed, amount of available RAM,
amount of available hard disk space, and sometimes the amount of video memory.

If your hardware does not meet or exceed the minimum requirements, the software will not run, or will
perform poorly. In some situations you may be able to adjust your hardware; for example, you can
clear off some disk space or add more RAM to the system. In other cases, you should probably look
for different software that will work with your current hardware setup.

Application Types

While operating systems control hardware and manage files, an application program performs a
specific function such as accounting, word processing, or drafting. Standard categories of application
programs include:

Word Processing Utility Multimedia
Presentations Accounting Web Browsers
Graphics Spreadsheets Suite
Electronic Mail Database Management Customized

Within each category, there are several available software programs with industry-wide acceptance.
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Microsoft Word entering and editing text (using editing keys), writing in
Arabic and English; changing option, using roller, move around the
document, selecting text (word, line, paragraph, pages, and all pages)
save; close; open documents; customizing view, edit text using (redo,
undo, cut, copy, and paste) formatting text using front command, paint
.brush, and alignment types, spell check and correction
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Moving Around the Document

You can move quickly to another area in the document by moving the mouse pointer to the new
location and clicking, or by using one of the following keyboard methods:

Movement Desired Press Movement Desired Press
Next Character Next Line
Previous Character Previous Line

Next Word + Next Paragraph +
Previous Word + Previous Paragraph +
Beginning of Line Next Screen
End of Line Previous Screen

Beginning of Document + End of Document +
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Entering and Editing Text
Exam 2 - Objective 1.1, 1.3

Typing involves using the keyboard to input text that is shown on screen. Editing includes actions such
as inserting and deleting single characters, words, or multiple lines of text, correcting typographical
errors, and inserting or deleting blank lines between paragraphs.

The following are basic concepts related to typing and editing text:

Insertion Point

The insertion point displays as a vertical blinking bar that shows where Word will
insert typed text and pasted items. It moves to the right as you type. The insertion
point is commonly referred to as the cursor.

Typing Text

Word is set by default to insert text; this means you can move the insertion point
anywhere in the document and Word will insert the text you type to the right of
that point. As you type, any existing text will be “pushed” to the right.

Deleting Text

There are two ways to delete text one character at a time. You can press the
key to delete one character to the right of the cursor, or the

key to delete one character to the left.

Word Wrap

When you have typed enough words to fill a line, Word will automatically shift
the insertion point to the beginning of the next line. This is called wrapping text.
If you are in the middle of a word that is too long for the line, Word will shift the
entire word to the beginning of the next line.

Ending Word Wrap/
Blank Lines

When you are finished typing text for a line or paragraph, you can press the
key one or more times. Word will insert as many blank lines as you want
and shift the insertion point to the beginning of the line below the last blank line.

These basic concepts are applicable to all word processing programs, regardless of the software
vendor. A major benefit of word processing programs is that they can be used to create documents
ranging from short letters or memos to larger, more complex documents like manuscripts, Web pages,

and brochures.

Another benefit of word processing programs is that they enable you to give your documents a
professional look through the application of a variety of design elements. You can also incorporate
design elements into a style or template to ensure you use them consistently.
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Understanding tap settings, working with indents, organizing list,
working with paragraphs, change line space, set paragraph space,
working with style, and using quick Styles, finding and replacing items,
document formatting, page background and watermark, learn how to
write Arabic in English Direction, and write English word in Arabic
.Direction
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Using the Selection Bar

Another way to select larger amounts of text is with the selection bar. The selection bar is located in
the white area at the left edge of the text, in the area that constitutes the left margin. When the mouse
pointer is positioned within the selection bar, it changes to a right pointing arrow as shown in the
following:

beautiful state of Washington!

With more resources on the West Coast, we will be able to offer more service and faster communications with
customers and new vendors. We are also exploring new opportunities and services we can offer with the focus to
the Pacific / Asian coast lines.

Please Fill In the Blanks ...

é] After a few delays, we are pleased to announce that we have finalized our first tour offering using the camel trains!

To make a long story short, we have now selected and confirmed the vendor who is partnering with Tolano
Adventures to offer you some spectacular tours in the Middle East and Australia! Call your Travel Director for more
details on these tours, or check out the details at www tolanoadventures.com.

We are also excited to announce that the Haunted Tours have taken off with great success, with many customers

animinm tha tnire in @ratland acnarialls af Fdinhiirah Cactla whara thara hawa heaan mane richtinas Af 3 winman

You can use any of the following methods to make selections using the selection bar:
e To select a line of text, click at the left of the line of text.
e To select a paragraph, double-click at the left of the paragraph.

e To select an entire document, triple-click anywhere in the selection bar, or press the key and
click anywhere in the selection bar.

Selecting Consecutive Text

You can select text using the mouse or keyboard, and occasionally you may want to use a combination
of mouse and keyboard to select larger pieces of text.

To select text using the mouse, position the mouse pointer at the beginning of the text to be selected
and then drag to highlight the text. You can increase or decrease the selection as long as you hold
down the mouse button. You can highlight forwards or backwards from the starting point.

To select text using the keyboard, position the insertion point, hold down , and then press the
arrow keys to move the insertion point to highlight the text. Release when the text is highlighted.

To select a word, double-click the word. To select a sentence, hold and click anywhere in the
sentence. To select a paragraph, triple-click anywhere in that paragraph.

To select the entire document, use one of the following methods:
e Onthe Home tab, in the Editing group, click Select and then click Select All; or

ititle Subtle Em... Emphasis |+ [\‘ Select~
"[; Select All

[J; Select Objects

Select All Text With Similar Formatting (Mo Data)
Ok Selection Pane...

e press Ctri)+(A).
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Page setup (change paper size, orientation, margins) insert page breaks,
adding page number or titles, applying columns and how to use it,
preview and print documents, using multimedia files (insert images,
objects) and manipulating them, using tables (create new one insert
.Excel table selecting items in the table and formatting tables
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When you save a document, Word automatically assigns a.docx extension to the end of the file name;
however, you can save the file in a different format, if necessary. By default, Word selects the My
Documents folder within the Documents library the first time you use the Save command in a new
document. You can save the document to that location or any other location you choose. If you specify
to save the document in a different location, Word will display that location each time you save or open
a file, until you change locations or exit Word.

To save a document, use one of the following methods:
e Click the File tab and then click Save or Save As; or
e on the Quick Access toolbar, click the EH (Save) button; or

o press (Cil)+(S).

To save an existing document with a different name, use Save As in the File tab.

The first time you save a document, you will see the Save As dialog box. Word will also automatically
insert the first line of text in the document into the File name field, on the assumption that you want to
use this string of text as the file name. Type over this selection to specify the file name you want.

File names can be up to 255 characters long, including the drive and path (such as C:\Documents\Draft
Proposals\January 29 Proposal to ABC Company.docx). Consider that using descriptive file names
helps you locate what you want easily, but excessively long file names will not fully display in most
dialog boxes. If your organization enforces a file naming convention, be sure to adhere to the
guidelines.

How often you save a document depends on how much work you put into it. If you make a large
number of changes, save the document frequently as you work to preserve your changes. If you're not
sure whether you'll need a certain document again, err on the side of caution and save it.

On occasion you may find that Word displays a prompt indicating there may be a compatibility issue
to address. This can occur when you want to save a document that was saved in a previous version of
Word, or if you try to open a file that has a file format that Word does not recognize as a default file
type that can be opened automatically in Word. When this occurs, give some thought as to which file
format you want to use and select it appropriately from the Save as type field in Word.

Save as type: | Word Document (*.docx) v ‘

Word Document (*.docx)

‘Word Macro-Enabled Document (*.docm)
‘Word 97-2003 Document (*.doc)
|Word Template (*.dotx)
Word Macro-Enabled Template (*.dotm)
Word 97-2003 Template (*.dot)
PDF (*.pdf)
XPS Document (*xps)
Single File Web Page (*.mht;*.mhtml)
e Folders Web Page (*.htm;*.html)

|Web Page, Filtered (*.htm;*.html)

~|Rich Text Format (*.rtf)
Plain Text (*.txt)
‘Word XML Document (*xml)
‘Word 2003 XML Document (*xml)
Strict Open XML Document (*.docx)
OpenDocument Text (*.odt)
Works 6 - 9 Document (*.wps)

Authors:

Another message box you may see when dealing with compatibility is similar to:

s ™
Microsoft Word [ 7 [

Your document will be upgraded to the newest file format.

While you'll get to use all the new features in Word, some minor layout
changes are possible. If you prefer not to upgrade, press cancel and
check the maintain compatibility checkbox.

7] Do not ask me again

—— ==
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Saving Documents

It is important to save your documents frequently as you work on them. This ensures that if an
unexpected problem arises, such as a power outage, you will have a recently-saved version of your
work and not be forced to recreate all of it. You can save files to any location on the local drive, a
network drive, or a portable media device such as a USB flash drive. Once you have saved a file, you
can retrieve or open it from any of these locations. You can have multiple documents open on the
screen, including new documents that you have not saved yet.
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Microsoft Excel: understanding basic terminology (worksheet, work file,
Cell, cell pointer, cell content, row and column reference) building
formula, mathematical operations, hierarchy of the main mathematical
operations, management workbooks (create new one, create from
template, enter data, moving around, saving, opening, closing
.workbooks).
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Understanding Basic Terminology

E Exam 2 - Objective 3.1

An Excel worksheet is similar to a very large sheet of paper divided into rows and columns. Rows are

numbered from 1 to 1,048,5676; columns are assigned letters or letter combinations from A to Z, and
then AA to ZZ, then AAA to AZZ, and so on up to XFD.

A B C D E F G H J K L

]

M N -

~ W AW N

o o w

Sheetl V{—"\

Workbook A single Excel file containing one or more worksheets {Sheet1, Sheet2, Sheet3).

Worksheet | A single report or tab in a workbook; by default each new workbook includes only one
worksheet but you can quickly add new worksheets as needed.

Cell The intersection of a row and a column; can contain one single value (text or number),
or formula.

Cell Address | The column-by-row intersection designated by the column letter and the row number,
such as A1 in the figure above.

Active Cell The cell currently displayed with a thick border, such as cell A1 in the figure above.
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Manipulating the contents (selecting cells; columns; rows; worksheet,
using undo and redo, copying and moving data, changing column width
and row height); auto filling technique; deleting and editing content;
delete and insert row or column; formatting cells (hnumber; font;
alignment; border; color, and shading; protection of cells and
worksheet)
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Managing Workbooks
Exam 2 - Objective 1.3, 3.1

As you begin using workbooks and individual worksheets to generate reports, you need to understand
basic file management to enable you to use the files again, such as save a file, open a file, create a new
file from a template, close the file or open another file.

Creating a New Blank Workbook

When you start Excel, the Backstage view appears so you can create a new workbook or open an
existing one. If you create a new blank workbook, it is automatically named Book1. Each time you
create a new workbook during the same session, Excel will number it sequentially as Book2, Book3,
and so on. When you exit Excel and start it later, the numbering begins at 1.

To create a new blank workbook, use one of the following methods:

e Click the File tab, click New, and double-click Blank workbook; or

e press(Ctl)+(N)

Creating a New Workbook from a Template

You can create a workbook using a template or pre-designed workbook provided by Microsoft. This
provides a consistent look for specific types of reports. The number of templates on your screen may
vary, depending on what has been previously installed and on what is currently available from online
Web sites.

To create a new workbook using a template, click the File tab, and click New.
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Creating simple and complex formula using different types of writing,
using absolute and relative address, understanding coming error values;
using common built-in functions (sum, average, Max, min, count, count
a, count blank, if, round, Sqrt, today, Day360, left, right, mid, trim)
copying formulas; inserting and deleting worksheets; formatting tables
.using auto format
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Creating Simple Formulas
Exam 2 - Objective 3.1, 3.2
A formula is a calculation using numbers (or other data) in a cell or from other cells, such as:
» automatically calculating sums horizontally and vertically

e performing “what-if” analyses by performing a calculation based on one or more changing input
values, such as estimated profit for a business during the next year

s using one or more Excel functions to perform tedious or complex calculations, such as monthly
mortgage payments.

Formulas can be linked from one worksheet to another, so that when you change values or amounts

in the active worksheet, dependent cells in the other worksheet will be automatically updated. You can

use a single cell as the reference point, or you can create complex formulas with many cell references

as well as built-in functions.

To begin a formula in any cell, you must type an equal sign (=). You can enter a cell address into a
formula either by typing it directly into the cell, or by clicking on the cells to be included. The cell into
which you enter a formula will display the result of the formula; the formula itself will be visible in the
Formula bar.

Some formulas are long and can include many calculations. If you need to change a formula, you can
use the key to edit the formula in the cell, instead of re-entering the entire formula from scratch.

Cells containing formulas can be copied to other cells. If these formulas contain cell references, Excel
will automatically adjust the cell references when you paste the formulas into a new location.

Excel calculates formulas in “natural order”: exponents first, then multiplication and division, and then
addition and subtraction. This order can be altered by inserting parentheses around portions of the
formula; Excel will calculate the portions inside parentheses before calculating the other items in the
formula.
The following symbols are used in Excel to represent standard mathematical operators:

¥ Multiplication + Addition

/ Division - Subtraction

When Excel detects an error or inconsistency in a formula, it displays a suggestion for correcting it.
The type of error message depends on the type of error, as indicated in the following examples:

‘We found a typo in your formula and tried to correct it to:

=B5-A5/D4

Do you want to accept this correction?
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Working with charts (create chart, select chart elements, changing chart
types, positioning, and resizing charts, chart and Excel titles) changing
background and color effects, changing data series color, adding or
removing Legend and data labels and data tables and gridlines); sorting
data ascending and descending, sorting multiple Fields, faltering data
using Auto and customized type; customizing printout using options,
previewing and printing worksheet
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Selecting Chart Types

As noted previously, the type of chart you select will depend on what you are trying to show. Line
charts are better for trends, bar charts are better for volume, and pie charts are best for showing
oortions of a total.

Excel provides a variety of chart types and several subtypes within each major type:

Change Chart Type

I Recommended Charts | All Charts \
™ Recent )
e | (LN (A (A8 Ho 58 95 50
|_|]|]][ Column
A Line Clustered Column
‘CD Pie Cuet T e T
E Bar : ‘ =
@ Area E -
i xS | |: i 010 A L
Lﬁiﬁ_ Stock ] ] ) E R — al.! P :.,_.
@ Surface
}‘i;' Radar
Lﬂh Combo
Column Compares values over time or categories in a vertical presentation.
Line Compares continuous trends.
Pie Compares series that make up a whole.
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Working with Charts
E Exam 2 - Objective 3.2

A chart is a pictorial representation of data in a worksheet. A chart can be a more descriptive way of
representing your data, as it can clearly illustrate trends or patterns in the data.

You can create a chart by selecting data from the worksheet, and then select the type of chart to insert
into the worksheet. Once you have created the chart, you can save it with the workbook. You can create
an embedded chart that displays on the same sheet as the data, or you can create charts on their own
sheets.

Each set of data in a chart is a series. The chart’'s horizontal line is the X-Axis, and the chart’s vertical
line is the Y-Axis. You can apply labels for both axes. If the information contains several data series,
you can add a legend to explain the meaning of each series.

To ensure you get the best results when printing charts on a black-and-white printer, try using gray
shades, monochrome, or the black/white options to differentiate the data on your chart.

To create a chart, select the cell range(s) for the chart and then, on the Insert tab, in the Charts group,
click the chart type.

- ih- =-%- n
0% e e 1
Recommended ~ = ° PivotChart
Charts L RS -

Charts Pl
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Chart Title | Add a title for the chart.

Axis Titles | Add titles to the horizontal and vertical axes; you can also customize items for the chart,
such as the units used in the vertical axis.

Legend Include a legend and position it in relation to the chart.

Data Labels | Include data labels on the chart.

Data Table | Display the chart data beneath the chart.

Axes Include labels on the horizontal and vertical axes.

Gridlines Include gridlines on the chart.

Excel provides a variety of pre-built layouts that you can apply to your chart, or use the Quick Layouts
option to display some common layouts used for charts.

imE e e

Quick  Change
Layout~ Colors~

i ir‘l =

1EE | [

You can further modify the chart with your own layout changes, using one of the following methods:

¢ Click the chart element you want to modify and then click the appropriate options to change the
chart element; or

¢ on the Format tab of the Chart Tools ribbon, in the Current Selection group, click the arrow for the

chart element field to select the item, and then click appropriate options on the Chart Tools ribbon
to modify the chart element, or

¢ Click * (Chart Elements) at the right of the chart to display a menu with more options for selection.

]

{_ CHART ELEMENTS

ORROOORORA

Axes

Axis Titles
Chart Title
Data Labels
Data Table
Error Bars
Gridlines
Legend

Trendline

By default, Excel will place the chart in the same worksheet as its source data. You can move this chart
to its own sheet, back to its original worksheet, or to a different worksheet using the Move Chart
command, or perform a cut and paste of the chart from one sheet to another.
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Changing the Chart Layout

Excel generates a chart using standard defaults. Modify the layout to create exactly the look you want.
Use commands on the Chart Tools ribbon to manipulate items on the chart.

80



Ministry of Higher Education & Scientific Research
Al-Rasheed University College

Department of Medical Engineering
instrumentation Technique

ge.laﬂ Caxdllg L";la.ﬂ ekl 8519
daslndl wds i A8

dudall 83421 LGS duwdid eud

488 ...90.... 1 - Qg9 pdallg dlgll B pualaall - AGEY Baa gl

109 uadlg dl ¢l B s loeadl LBl

e 1038 Gl 0 6 of Aada) g B gl
(Cis ) sall) Apana@ill (ia g pall gmali e =il ]
ole Baaaial) Jasad gl JLaal -zl G el ) Jada il el oLits) oyl 2
@M‘ U‘)’J‘

109 rwadlg d1 gl B polrall Ol g g0

Understanding PowerPoint and the presentation; what does a
presentation include; working with presentations (creating, saving,
closing, or opening presentations); moving around in presentation,

managing the slides (inserting; deleting; rearranging slides, changing
layout, changing or modifying themes.
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What is PowerPoint?

PowerPoint is a presentation program that you can use to create, edit, and manipulate slides for
on-screen presentations, sending via email, or promoting products or services on a web page. These
presentations can be delivered to live audiences, or viewed individually (self-directed) by others at their
convenience.

You can enter text, draw objects, create charts, or add graphics. You can choose to print a presentation
or share it over the Internet.
Consider the following tips when creating a presentation:

e Use bullet points or numbers to show procedural steps. Keep the number of points on each slide
to a minimum (no more than six recommended), thereby keeping the text brief.

¢ Set up tables to summarize data, and make sure the data within the tables is legible.
¢ Include charts to show data patterns or trends, and also show the data sheet for reference.

¢ Include pictures of varying types. For instance, you might want to include the organization logo on
every slide, or a picture of a new product with bullet points on its features and benefits.

¢ Customize the master slide with the company logo, web site address, and contact information to
remind the audience of who you are and what you are presenting. You can then distribute copies
to your audience with key points from your presentation.
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What Does a Presentation Include?

PowerPoint is used to build a presentation slide by slide. Those slides, shown in order, make up your
presentation. Different slide types serve different functions.

Title Slide

Agenda
Slide

Slide 1

Slide 2

Slide 3

Summary
Slide

Each slide includes placeholders—a dashed-
line box with a tip that tells you what you can

Title Slide

This is the opening slide that introduces the subject of the presentation. The title slide
usually includes the title or topic, and a subtitle. The subtitle might be the presenter’s
name or the presenting organization’s name, or it might be the date and location of the
presentation.

Agenda Slide

This slide usually lists the titles of all the slides in your presentation. The agenda slide is
often the second slide in a presentation. It provides an overview of what will be covered,
and can help the viewer grasp the flow of the presentation.

Title and Content Slide

This type of slide is the most frequently used layout. The layout controls which
placeholders appear on a slide. A title and content slide is commonly referred to as a
bulleted-list slide because it includes a title and a bulleted list. The list includes the key
points the speaker wants to make about a specific topic. Bullet points should be brief,
concise, and clear.

Support Content Slides

You can add various kinds of content to your presentation using different content
layouts. Content can include text, design elements, diagrams, videos, tables, charts,
sounds, animation, or special transitions from slide to slide.

Summary Slide
The summary slide is the last slide in the presentation. It reviews your presentation,
reinforces the key messages, and provides contact information for further details.

Click to add title

use the box for. The blank slide layout,
however, does not include placeholders.

You can click inside a placeholder to insert text * Click to add text

or an object.

When you see a placeholder like the one at the
right, click an icon in the box to insert that
particular type of object.
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Managing slide objects (using select vs edit mode; manipulating text;
create tables and charts; inserting pictures or clip art or multimedia);
creating a master slide; animating objects (customizing the animation,
applying slide transitions); running the slideshow and set up the
presentation, previewing and printing presentation.
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Closing a Presentation

Once you have finished working with a presentation, save and close it to clear the screen. To close a
presentation, use one of the following methods:

e Click the File tab and then click Close, or
e Press (Ctl)+(W) or (Ctl)+(F4), or
¢ (Clickthe * Close button for the application.

When the last open presentation has been closed using one of the first two methods, the application
window becomes gray and the only ribbon tab available is the File tab. You use the File tab to open or
create a new file.

Opening a Presentation
You can open a presentation file using one of the following methods:

¢ Click the File tab, click Open, click the location where the file is saved, and click the file from the
list of Recent Presentations; or

¢ click the File tab, click Open, click the location where the file is saved, click Browse to navigate to
the folder where the file is saved, select the file and then click Open, or

e press Ctl)+(0), click the location where the file is saved, click Browse to navigate to the folder
where the file is saved, select the file and then click Open or

e open it directly from Computer or File Explorer.

If the file was saved in a different file format than PowerPoint 2013, click the All PowerPoint
Presentations button to choose another file format:

All PowerPoint Presentations v
All Files

Presentations and Shows
PowerPoint XML Presentations
PowerPoint Templates

All Web Pages

Office Themes

All Outlines

PowerPoint Add-Ins
OpenDocument Presentations

If you open a file that was saved from an attachment in an email, Protected View will display an
information bar requesting you to enable editing in the file before you can make changes to it (see
below). The Protected View feature protects you from the possibility of opening a file that may contain
a virus; always save and scan any attachments you receive via email before opening the file in the
application program. Alternatively you can apply this feature when opening a presentation to prevent
any accidental changes being made to the file.

B d & s Green Soles 2013 Getting There is Half the Fun [Protected View] - PowerPoint 7T EH - O X
HOME INSERT DESIGN TRANSITIONS ANIMATIONS SLIDE SHOW REVIEW VIEW Lucylee ~ @&
Layout Shape Fil % Find
Reset hape Outlin " Replac
e " Section= | B T U 8 akx R O it | RS-
Clipboard & Slides Font Paragraph Drawing Editing

o PROTECTED VIEW Be careful—email attachments can contain viruses. Unless you need to edit, it's safer to stay in Protected View. Enable Editing
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Moving Around in the Presentation

To navigate between slides in the presentation, use one of the following methods:

e Click the |E| (Previous Slide) button or press to move to the previous slide in the
presentation; or

e click the E (Next Slide) button or press to move to the next slide in the presentation; or

e in the Outline View or Slide Thumbnails pane, click the slide you want to move to in the
presentation; or use the (1) or (1) keys to move between the slides; or

¢ inthe Slide Sorter view, double-click the slide you want to view.
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The internet browsers and the world wide web (the internet, the world

wide web, web browsers); understanding website address (website
protocols, resource names)
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The Internet

The Internet is a vast global network that functions in much the same way as your school or company
network. A network is an arrangement of computers that are connected in such a way that they can
communicate and share information with each other. Networked computers use special networking
hardware to form the connections that make communication possible.

The Internet is comprised of many smaller networks which are connected together so that they can
communicate and share information. The hardware used to connect a computer to the Internet is the
same hardware used to connect a computer to a company or school network, and the hardware that
forms the core of the Internet is not much different.

In fact, the Internet is a collection of hardware. It consists of wires, routers, switches, microwave links,
servers, and communication protocols. Because the Internet is so large, companies, schools and
individual users do not connect to it directly; instead, they connect through a middleman called a
service provider.

When you purchase (or subscribe to) Internet service, you pay an /nternet Service Provider (ISP) for a
connection to the Internet. (You actually connect to the ISP's network, which in turn is connected to the
Internet.) The ISP provides the connection, and the connection provides access to the Internet (and all
the smaller networks connected to it).

Clients and Servers

It is important to understand that on the Internet (as on any network), some computers function as
clients and others function as servers. A client is any computer that requests a service or resource
(such as a document or web page) from another computer on the network. A server is any computer
that provides services or resources to other computers (clients) that request them.
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The World Wide Web

While the Internet is a network comprised of hardware connections, the World Wide Web is a system
of interlinked documents that are accessible on that network called the Internet. There are countless
millions of documents hosted on web servers —and if you can access a document by typing its address
into a web browser, or by clicking a link that takes you to it, that document is part of the World Wide
Web.

Documents hosted on web servers are generally referred to as web pages, and web pages usually
contain links (called hyperfinks) to other pages located on web servers around the Internet. If you have
ever visited a web site and clicked a link that took you to another web site (or to another page within
the same web site), then you have used a hyperlink. These hyperlinks form the connections that make
the World Wide Web possible — web pages around the world are connected to one another by
hyperlinks.

The Internet is the network (that is, the hardware) that allows users to access documents on the World
Wide Web, and the World Wide Web is the vast collection of "connected" documents available on the
network known as the Internet.

Web Browsers

As you saw in the previous exercise, an Internet connection allows you to contact a web server and
receive a reply. But in and of itself, this is not terribly interesting. To actually view web pages and
navigate web sites, you need more than simply an Internet connection — you need a web browser.

A web browser is a program that enables you to view and navigate web pages on the Internet, and to
experience the amazing rich media that is available on the World Wide Web. That is, a web browser is
software. Web browsers are highly sophisticated programs. Their most basic function is to display
pages created with hypertext markup language (HTML). HTML is a special language that web page
designers use to add text, hyperlinks, applications, video clips, sound and animation to web pages.
When web pages are designed properly, visitors can “point and click” to launch applications, navigate
to specific areas of the web site, or visit related web sites — all within a web browser window.
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Browser Functions

Browsers perform several functions. Among other things, they retrieve and display web pages, allow
users to navigate around the World Wide Web, play media files, and support encryption to allow for
secure web transactions. In the following section, you will examine a few of the basic functions of a
browser.

Addressing

As you have already learned, you enter a URL into the address bar in the browser to indicate which
web site you want to visit. When you type a web site address into the address bar, the browser sends
arequest to the appropriate web server. The server receives the request, retrieves the appropriate web
pages, and then sends them back to your browser. The browser then formats and displays the web
pages for you within the browser window.

The address bar displays the URL of the page currently displayed in the browser window. You can visit
any web page by typing its URL into the Address bar and pressing (_Enter ).

As you navigate to other pages within a web site (or as you visit pages on other web sites), the URL
shown in the Address field updates to show the address of the current page. Most browsers maintain
a history of URLs that you can access from the address bar. Clicking a URL displayed in the address
bar history list has the same effect as entering the URL directly into the address bar.

In addition to displaying the URL, the address bar often includes several buttons. The Internet Explorer
address bar is shown below:

B http://www.bing.com/ P~C

The Internet Explorer address bar includes the following buttons:
Search You can search directly from the Address bar in Internet Explorer, instead of first
accessing a search engine page. Enter your search criteria in the Address Bar and then

click the » (Search) button or press to view a list of web sites related to your
search criteria.

Show Click the ~ (Show Address) button to display a history of the URLs of previously visited
Address web sites.
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Instant Messages

Sometimes called IM, this type of electronic communication allows two or more participants to
"converse" with one another in real time by typing messages into the window of an instant messaging
program. Instant messaging programs such as Microsoft Lync, Skype, ICQ, Google Talk, or Yahoo!
Messenger enable people to “chat" with each other, regardless [,

of where they are located. For example, two participants may What's happeniing today?
be working on different floors of the same office building, and % g:ﬁ:::'_McSwee"ev

a third participant might be working in an office across town.

Instant messaging is a very useful means of communication to &S "1 /| k-
use when an answer is needed quickly.

Lync = 0 X

Set Your Location ¥

| Find someone p

In order to use an instant messaging program, you must create | GROUPs STATUS RELATIONSHIPS | NEW
an account with a username and password. Many instant | “ ™"

messaging clients are associated with online services, such as
an email account. For example, if you have a Microsoft

v Re

4 Other Contacts (0/4)

Ethel Gustafsson - Offline 38 days

Account, you can use your username and password to sign Fred, Dearmom,- Offine & days

into Microsoft Lync (a program included with Microsoft Office Philip Henderson - Offfine 45 days
365), or you can message someone in the Contacts list of 1505 26 BMIke S e arvl Eaming 2 ot
QOutlook.com using the one account. i E:ﬂiflf”fﬁ?ﬂ,L;J.Q‘E}‘Zf‘.i.f’"

4 Work Team (0/4)

The figure is an example of the popular Microsoft Lync uCm,ynsmens,HWMM
communications program commonly used in a business

Late start today ...

environment, and a quick look at this program. You will find Lawrence Jang - Presence unknown

that all instant message programs share similar features and it S [ Ucy Lee - Offline 2 days

is a matter of determining where the command is located in ; ;Mla’;enw ripesst

that program. For instance, the Yahoo! instant messaging L8l Waiting for the snow to -

program refers to contacts as Buddies.

Information Bar Enter a brief description of what you are working on, something you want to
draw attention to, such as an upcoming company event or the release of a new
product.

Profile Name of person signed in along with a picture and two fields identifying your

availability status and your location.

View Icons The first three icons enable you to view contacts, view conversations, or view
any meetings scheduled for the current day.

Options Icon At the far right is the gear icon that allows you to change settings for how Lync
works.

Show Menu button | Click this button to display other actions you can perform such as sign out of
the program and start an online meeting with someone else. You can also
choose to display the menu bar at all times.

Display Options Choose the tab to view the contacts, such as in groups, by status, relationship,
or the new contacts you added but have not organized as yet.
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Text Messages

Text messages are similar to instant messages except they are sent over a cellular provider's network
using a protocol called Short Message Service (SMS). Text messages are created and sent from cellular
phones (or other similar mobile devices). As the name of the protocol implies, the number of characters
allowed per message is limited (about 100 to 200 characters per message, depending on the service
provider). You can send a text message to one person or to many people, however the message may
take longer to reach certain recipients, depending on the cellular network involved. The figure shows
six text messages that form a conversation.

Electronic Mail (Email)

Like postal mail, a valid address is required to send messages; however, the messages are sent
electronically using an account provided by an ISP or your organization. Email is also similar to postal
mail in that just as the recipient of a letter need not be at home in order for the mail to be delivered, an
intended email recipient need not be logged on to an email program in order to receive an electronic
message. An email Inbox is very much like a postal mail mailbox. Letters sit in a mailbox until the
recipient opens the box and brings in the mail. Email messages sit in a recipient's Inbox until that person
logs on and checks for messages.

VolP

Voice over Internet Protocol (VolP), allows you to make voice calls using a broadband Internet
connection instead of a traditional (analog) telephone line. VolP, also known as /nternet telephony or
Voice over Broadband (VoBB), converts analog voice signals into digital data packets, adds addressing
information to each packet, and then sends the packets across a data network (such as the Internet).
Many businesses use VoIP services because they are less expensive than traditional telephone
services, especially for long-distance calling.
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Video Conferencing

Video conferencing allows people in geographically distant locations to participate in a conference with
one another. Attendees at each location gather around a table in a room equipped with a video camera,
microphone, video screen and speakers. (In some setups, only cameras and screens are used, and
audio information is relayed over a conference
telephone.)

Video cameras at each location record the attendees,
and the videoconferencing software sends the
recorded data (usually over the Internet) to the other
locations in real time, much like a live broadcast. The
intention of videoconferencing is to allow participants
to see nonverbal communication and has often been
advertised as “the next best thing to being there.”

In practice, however, most videoconferencing
systems are nothing like being there. The videocast images are too small, or the cameras do not
capture hand and arm motions, or the participants appear to be looking away from the camera.

Some manufacturers, such as Cisco systems, offer telepresence systems to enable long-distance
business meetings over high-speed networks. Telepresence systems are reported to be a vast
improvement over standard videoconferencing systems. They require the following:

A camera that is optically aligned with the eyes of the person on the screen.

2. A life-size image with upper body arm gestures clearly visible. For desktop conferencing, smaller
images are acceptable but no less than about 70% of life-size.

3. Correct cultural distance where the image of the person is at table height and the image resides
just beyond that, as if sitting on the other side of a meeting table.

4. Image that is broadcast quality or better in resolution.
5. Audio quality that is superior — voices sound crisp and clean, free from distortion.

Although business telepresence systems can save money on travel, these products are expensive to
purchase and install, and are not in wide use.
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Using Microsoft Outlook: (creating new messages, receiving messages, working with
attachments, managing spam, emptying the junk e-mail folder, automating outlook)
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Using Microsoft Outlook
E Exam 3 - Objective 3.1

Note: Although many email programs are currently available, for the purpose of this courseware we will use
Outlook 2013. Remember that the concepts remain the same regardless of the email program; the differences
lie in where the commands and features are located in each program.

Microsoft Qutlook is a popular program for managing email, and it also includes modules to manage
information such as appointments, contacts, project notes and task lists.
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When you open Outlook, your screen will look similar to the one shown below:

@ [_‘EI ] Inbox - amcsweeney@tolano.com - Outlook ? H - O X
HOME SEND / RECEIVE FOLDER VIEW
= ol | Bxlgnore x p 4 ‘ L' , E2Meeting ¥ Move to:7 WiMover (3 Unread/Read |Search People ,T_‘
&= % CleanUp- —€ € I ggy. €3 To Manager -| fSRules- Wi Categorize~ [ Address Book i
New New Delete  Reply Reply Forward = = Send/Receive
Email kems~ & Junk~ All ) More - Team Email 7| MioneNote  |* Follow Up ~ Y Filter Email - All Folders

4 Favorites
Inbox
Sent Items

Deleted Items

4 Qutlook Data File

Inbox

v es  Steps r Mov s Rec
vew | Contents Pane Respond Quick Step 0 Move Tag Find Send/Receive S

Search Current Mailbox (Ctrl~E) p (rm-e €2 Reply (G2 Reply All £} Forward G5 IM

Wed 16-May-12 1:15 PM

A Unread ByDate ~  Newest 4
e awrence Jang <ljang
, Spring Brochure
Lawrence Jang ] g
Spring Brochure 16-May-12 To amcsweeney @tolano.com A~
Drew, I'm sending back the Spring brochure :
= 2 Message =) 2-fold Spring brochure.docx (192 KB)

Nicole Locklear

Drafts Folder
Sent Items List

Deleted ltems
Junk E-mail
Outbox

RSS Feeds

Search Folders

= om s [ e

4 amcsweeney@tolano.com <—| QOutlook Data File | Mount Rainier Park.
Inbox 3 When does Ji Mai start? We can possibly ask her as I
Drafts remember her saying in the interview that she had hiked
in many US national parks, including two in Washington
Sent Items V r‘t' | S It B State,
Deleted Items ertica phr ar
Junk E-mail Also, what did you say was going to be placed on the -

Business Cards 16-May-12 -
Hi, Drew I'm at the printer's location right Drew,

Lawrence Jang I'm sending back the Spring brochure for you to

Anticipated Arrival 10-May-12 complete - I like what has been done so far. I would

Hey, Drew Still anticip, suggest maybe we change the Seattle picture and insert

one showing how green Washington State is.

As you know, I used to live in Vancouver, BC and went
on many family vacations to Washington. I will ask my
sister if she has any photos from their recent trip to

Peeks Bar Lawrence Jang At

& ,.

Contents Pane

Displays the contents of the selected item for the active module in the Navigation
Pane. For instance, if Mail is active, the Contents Pane lists the messages for the
selected folder; if the Contacts module is active, you will see a list of contacts in the
Contents Pane.

Search

Enter search criteria and see the results display while you type.

Outlook Data File

Shows the folder list for the current Outlook data file. In the preceding image, there
is a data file for the default Outlook data file and then one for the student data file
being used in this courseware.

Folder List

Displays information for each module or folder, similar to viewing the Folders pane
in Windows explorer. Each module has slightly different options in the Navigation
pane, with Mail showing the most folders (you can create or edit folders).

Reading Pane

Displays the contents of any email message highlighted in the Content pane. By
default, the Reading Pane is displayed on the right of the email or tasks list when in
Mail or Tasks mode, but it can be repositioned below the list.

Vertical
Split Bars

Drag to show more or less of the pane on either side (in this case, folders or
modules). All vertical panes on the Outlook screen are separated by vertical split
bars. When you position the mouse pointer over a split bar, it becomes a split
symbol that you can then click and drag to adjust the size of the desired panel. If
you maximize the screen, Outlook adjusts the size and number of items you can
see in either portion of the Navigation Pane.

Peeks Bar

At the bottom of the Navigation pane, this bar shows icons or text for the other
Outlook modules. You can switch between the views by clicking the ellipsis (...),
click Navigation Options and then click Compact Navigation.

Navigation Pane

Move between different modules or components of Qutlook, or navigate between
the folders in the Mail module of Outlook.
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Digital citizenship identifying ethical issues (understanding intellectual
property, copyright and licensing); protecting your data or computer
(identifying software threats, understanding viruses), protecting
yourself while online; buying online; how much information should |
share? Protecting your privacy)
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Standards for Electronic Communication

E Exam 3 - Objective 4.1

There are no fixed rules regarding communications; there are, however, some guidelines and widely
accepted standards to consider when using electronic communications. These include:

+  Email should never completely replace another form of communication; before you choose email,
think about the purpose of your message, the response you are seeking, and how quickly you need
it. For instance, if you need technical support on a software issue immediately, it may be faster to
call the vendor or the IT department than to send an email. If a situation is best resolved by speaking
to someone directly, use the telephone or seek a face-to-face meeting.

s« Keep in mind that email or text messages are not real-time communication. Email messages (and
responses) can be subject to delay — especially if the recipient is away from their device for any
length of time,
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+  When writing a message, think about your audience. For instance, a business or school email
should have a professional tone and follow general business practices for correspondence. Even
when writing a simple text or instant message to a friend, give some thought to what and how you
are writing. For example, are you using acronyms or shortened versions of words (such as using
“u” instead of “you"}, and will the recipient understand these? Are you including punctuation in the
message? If the recipient uses the same format as you do for messages, they will understand what
these mean whereas a recipient who does not send a lot of text messages may find it difficult to
comprehend the message content.

+ Be as clear and concise as possible.

+ Always check spelling and grammar before sending your message, especially when sending
messages to business contacts. Proofread the message to be sure it makes sense and is easy to
understand. If the message includes hyperlinks, test the links to ensure that they work properly.
Remember that your email represents your organization or school and should reflect the
appropriate image.

» Consider the length of your message; for emall, if the message requires you to scroll more than
two screen lengths, it may be best to send it as an attachment, provide a link to further information,
or contact the person directly. Additional details such as pricing lists, assignments, or catalog items
should be provided as secondary references. The same principle holds true for text and instant
messages; if the message requires much explanation, it may be best to call the person directly.
The intent of messaging is to send information in a concise manner. When replying to a message,
consider how much of the previous message needs to appear in your reply. For instance, if this is
the fourth time you've replied to the same message, this reply will contain the entire history of this
communication (or the entire email “string” or "thread"). In some cases, you may want to keep this
as an official record; in other situations, it may not be necessary to show the history and you can
delete the earlier responses from the body of the message.

s+ Remember that business emails are official company correspondence; file and archive them using
the appropriate folders in your email program. This applies to all messages you send or receive
using an email address provided by your organization or academic institution. This may also be
true if you are sending messages using a mobile device that is owned and paid for by an
organization.

+ Use discretion when sending messages to multiple people. Does everyone need to receive this
message? What is the purpose of this message and who needs this information?

+ When replying to a message that was sent to several recipients, consider whether it is necessary
for everyone who received it to read your reply: you may need to respond to the originator only.
For example, suppose your supervisor sends an email reminding you to submit your travel budget
s0 he/she can complete the department budget; he/she might Cc the Accounting department as a
courtesy, to show them that more information is needed. In this case, your reply should be sent
only to your supervisor.

+ [f the message contains confidential or sensitive information, or requires a signature for approval,
consider which the best method of communication is, and whether using a traditional hard copy
might be better.

+ Be careful sending messages with personal jibes, ethnic jokes, or bad language, even to people
you know, as they can easily be misinterpreted or forwarded to other people who may take offense.

+  Avoid “flaming” people. A flame is an email or chat room message that personally attacks the
recipient. Such messages have no place in business or school communication, informal or
persunal communication, or instant messaging. If you have been flamed, it is best to ignore it. If
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Finding information searching for information (different types of
websites, searching a specific website); using search engine technology
(understanding how search engines work)
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Browser Features and Functions

E Exam 3 - Objective 1.2

There are a wide variety of browsers freely available for various operating systems, Browsers
commonly used on Windows systems include Microsoft Internet Explorer, Mozilla Firefox, Google
Chrome, Opera and Safari. The following images show each of these browsers. Note that although the
browsers function in much the same way, a web page may appear a little differently in each browser.
This is because a browser's coding determines how it interprets the HTML code used to define a web
page.

Microsoft Internet Explorer

Developed by Microsoft in 1995 and was one of the first graphical user web browsers, Internet Explorer
(IE) continues to be very popular for browsing the Internet as it is included with the Windows operating
system.

G o by MSN.Com 2= 2 ¢|d mshoom

Outlock com  Skype  Mobile MyMSN  Laino  Bing Rewards 7§ m m| W Follow Make M5H my homepage 'Welcoma to MSN ™

[ESE

Mozilla Firefox
Firefox was originally developed by Mozilla Corporation and Mozilla Foundation in 2004, As it is an
open source web browser that is free to download, it has gained popularity with each new release.

| il M%.com [

& B S = R | B~ Googie Ay B & #®

Tubookcoen  Shype  Woile  WMyMSN  Laine  Bing  Rewsnds T I | #romow Make MSH my homepage  VWelooms 1o M SH
Faas QEuoea | Hanin

Google Chrome

Chrome was developed and released as a stable product in 2008. It was originally available as freeware
although a large portion of its code was released in 2008 as an open source project called Chromium;
newer releases of Chrome are based on this version.

W MSH.com =g
- C | [ www.msn.com =
Skype Moblle MyWSM  Laino  Bing  Rawards T m:. oF Follow Maka MSH my homepage  WiHoome ix- MM
Fuga opbons | Sgn
Opera

Opera Software releases its web browser as an individual product for download or as part of an Internet
suite of products. It is one of the original web browsers introduced in 1994 and now is available for a
number of computing devices, including several mobile devices.
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Narrowing the search: evaluating information (reliability and relevance,
validity and authenticity, objectivity and bias)
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Searching

While there are several well-known search engine sites on the Internet (you will learn how to use a
search engine site later in this courseware}, many modern browsers include a search box in the address
bar, which allows you to search for information without first having to navigate to a search engine site.

In Internet Explorer, you can search directly from the address bar. Simply click in the address bar and
start typing. if you enter a complete URL, you will go directly to the web site. If you enter a search term
or an incomplete address, click a search provider in the menu to launch a search using the currently
selected search engine.

a l| I3 whale watching P == B sing
Bing Suggestions -
- whale watching seattle

whale watching
whale watching in maine

whale watching boston

whale watching cape cod

Turn off suggestions (stop sending keystrokes to Bing)

—

A list appears with suggestions of search criteria for selection; this is the Turn on suggestions feature
that is on by default. You can change this using the options command for the web browser.

You can also click the Add button in the drop-down menu to add search providers (such as Google or
Ask.com) from the Internet Explorer Gallery web site.

Typically, a search engine returns tens of thousands of results. You can use the following techniques
to narrow the number of results:

+ Choose specific key words. For example, typing femon sharks will show fewer results than simply
typing sharks,

=« Put quotation marks around a phrase or a group of keywords to force the search engine to look for
occurrences of those words together rather than searching for each of those words individually.

» Use Boolean operators. Popular Boolean operators you can use with searches are the words AND,
OR and NOT.

» Even if you do not type Boolean operators, most search engines interpret a space between
keywords as an implied Boolean AND. That is, if you type nuclear radiation in the address bar, the
space between the keywords is interpreted as a Boolean AND, and the results will include both
words.
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